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M20.iii 

ABSTRACT 

 
Javapeño (Java Plots, Especially Nice Output) is an interactive two-dimensional (2D) and three-
dimensional (3D) plotting package that is written in Java and operates on numerous computing platforms.  
Javapeño enables the plotting of data from TSUNAMI-A and TSUNAMI-B sensitivity data files, 
KENO V.a and KENO-VI data files generated with KMART and KMART6, XSDRNPM data files, and 
SMORES data files. Javapeño allows for visualization of data directly from binary AMPX master and 
working formatted cross-section data libraries and from binary COVERX formatted cross-section-
covariance data libraries. New for SCALE 6.1, Javapeño includes visualization capabilities for ENDF-VI 
and ENDF-VII continuous energy libraries as well as OPUS plot files of activition and decay data. 
Javapeño enables the user to manipulate data in an intuitive manner and provides a viewport for 
examining underlying physical processes. 
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M20.1.1 

 
M20.1 0BINTRODUCTION 

 
Javapeño (Java Plots, Especially Nice Output) is an interactive two-dimensional (2D) and three-
dimensional (3D) plotting package that is written in Java and operates on numerous computing platforms.  
Javapeño enables the plotting of data from TSUNAMI-A and TSUNAMI-B sensitivity data files, 
KENO V.a and KENO-VI data files generated with KMART and KMART6, XSDRNPM data files, and 
SMORES data files. Javapeño allows for visualization of data directly from binary AMPX master and 
working formatted cross-section data libraries and from binary COVERX formatted cross-section-
covariance data libraries. New for SCALE 6.1, Javapeño includes visualization capabilities for ENDF-VI 
and ENDF-VII continuous energy libraries as well as OPUS plot files of activition and decay data. 
Javapeño enables the user to manipulate data in an intuitive manner and provides a viewport for 
examining underlying physical processes.  Javapeño executes on any system with a Java Virtual Machine 
(JVM) version 1.5 or newer installed.  Java3D components are required for 3D plotting and Java 
Advanced Imaging components are required for image exporting.  The required installation files are 
distributed with SCALE 5.1 for Windows XP PCs.  Current versions of the JVM for many operating are 
available from Sun Microsystems at Hhttp://java.com/en/download/manual.jsp H.  Implementations of JVM 
for other platforms may be available from the manufacturer. 

http://java.com/en/download/manual.jsp
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M20.2 1BBRIEF OVERVIEW 

 
This section briefly describes how to launch Javapeño and how to access the key features available in 
Javapeño.  Subsequent sections, and the Javapeño interactive help, provide more details of the operations 
of the application. 
 
Once a current version of the JVM is installed, the user can launch the application by either double-
clicking the javapeno.jar file, or by running the javapeno.bat file or javapeno.sh script as appropriate for 
the particular computing environment, or by simply pressing the Javapeño button in GeeWiz.  
Additionaλλψ, Javapeño χan be λaunched by tψping “javapeno” at the comµ and prompt where the user 
executes SCALE.   
 
Once Javapeño launches, a window with a Javapeño graphic will appear in the center of the screen, and a 
menu bar will appear across the top of the screen.  SCALE files can be opened by selecting Open 

Dataset… from the File menu.  Once a SCALE file is open, a list of data available for plotting will 
appear in a window titled Reaction List on the right side of the screen as illustrated in XFigure M20.2.1X. 

 
 

  
Figure M20.2.1.  Javapeño application with data file loaded. 



 

 
 M20.2.2 

Double-clicking on an item in the list of data available for plotting creates a new plot window and plots 
the data using the default settings for the particular type of data loaded, as illustrated in XFigure M20.2.2X.  
To add more data to the existing plot, simply double-click on another item in the list.  To create a second 
plot, hold down the Ctrl key on the keyboard while double-clicking on an item in the list, or right-click 
an item in the list for more options.   
 
Plots generated with Javapeño can be exported as graphics file using Export… from the File menu.  
Printing directly from Javapeño is also supported.  When exporting or printing, only the currently selected 
plot is processed. 
 
 

  
Figure M20.2.2.  Javapeño application with plots drawn. 

 
Many features of Javapeño can be customized through user interaction.  Items available under the Format 

menu control the customization of the look of the plot.  Also, right-clicking or double-clicking on 
2D plots or shift-right-clicking of 3D plots provides a pop-up menu where options can be set.  Double-
clicking on the tab for a particular data file in the Reaction List window activates a dialog where the title 
used for the data can be modified, or the data file can be removed.  Javapeño allows for multiple data files 
to be open concurrently, so that data from different models can be plotted together.  The list of data 
available for plotting on the right hand of the screen corresponds to the currently selected data file. 
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M20.3 3BSYSTEM REQUIREMENTS 

 
Javapeño has the following system requirements: 

M20.3.1 11BREQUIRED 

1. Java supported operating system (OS) and processor.  Pλease see Java’s λist of supported 

HarchitecturesH at Hhttp://java.sun.com/j2se/1.5.0/system-configurations.html H.  If your architecture is 
not λisted, check ψour hardware µ anufacturer’s website.  For example, Appλe and HP are known 

to release their own port of Java. 
2. Java H1.5.xH+ must be installed.  Only the runtime environment (JRE) is required. 
3. HJava 3DH 1.31+ must be installed. 
4. HJava Advanced ImagingH (JAI) 1.12+ must be installed. 
5. 30MB of RAM free to run Javapeño. 
6. Java 3D Hsupported video cardH (to plot 3D data). 

 
For a more enjoyable Javapeño experience, the following system specifications are recommended if 
plotting 3D data. 

M20.3.2 12BRECOMMENDED 

1. 512 MB+ of free RAM 
2. 1.4 GHz+ processor 
3. Java 3D 1.4+ 
 

http://java.sun.com/j2se/1.5.0/system-configurations.html
http://java.sun.com/j2se/1.5.0/system-configurations.html
http://java.sun.com/javase/downloads/index.jsp
https://java3d.dev.java.net/binary-builds.html
https://jai.dev.java.net/binary-builds.html
http://wiki.java.net/bin/view/Javadesktop/Java3DFAQ#Q_What_graphics_cards_are_suppor
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M20.4 4BMENUS 

 
The functionalities of the five Javapeño menus, shown in XFigure M20.4.1X, are described in this section.  
 
 

 
 

Figure M20.4.1.  Javapeño menus. 

M20.4.1 13BFILE 

The File menu contains thirteen items, as shown in XFigure M20.4.2X. 
 

 

 
 

Figure M20.4.2.  Javapeño file menu. 

 



 

 
 M20.4.2 

 

M20.4.2 14BNEW PLOT 

The New Plot item activates a submenu, shown in XFigure M20.4.3X, for creating a new plot with default 
formatting. 
 

 
 

Figure M20.4.3.  Javapeño new plot menu item. 
 

 
The Default 2D Plot item creates a blank 2D plot with linear axes.   
 
The Default 3D Plot item creates a blank 3D plot. 

M20.4.2.1 62BOpen Dataset… 

The Open Dataset… menu item opens a dialog box where data files in the supported data formats can be 
loaded into Javapeño.  
 
Supported data file formats are: 
 

 XTSUNAMI Sensitivity Data X (default extension .sdf) 
o TSUNAMI-1D data in TSUNAMI-A format 
o TSUNAMI-3D data in TSUNAMI-B format 

 XKENO V.a and KENO-VI DataX (default extension .kmt) 
o KMART data files from KMART and KMART6 

 XXSDRNPM DataX (default extension .idf) 
o Data generated in Input Dump File, Balance Table File, and Activity Data File 

 XSMORES DataX (default extensions .plotd and .plote) 
o Effectiveness functions and density functions 

 XICSBEP Sensitivity DataX (no default extension) 
o International Handbook of Evaluated Criticality Safety Benchmark Evaluations 

sensitivity data 
 XGeneral 2D Plot DataX (default extension .plt) 

o General 2D data format 
 XCross-Section-Covariance DataX (no default extension) 



 

 
 M20.4.3 

o Multigroup cross-section covariance data 
 XCross-Section DataX (no default extension) 

o Multigroup cross-section data 
 XGeneral 3D Plot DataX (default extension .j3d) 

o General 3D data format 
 
Once a file is opened, a window appears presenting the user with the data available for plotting.  If cross-
section data were loaded, then the data are presented as a tree.  All other data are presented in a filterable 
list.  If multiple files are opened, a series of tabs are presented where each tab is used to show the data 
available in a single data file.  The presented data are only for the active tab.  The look of the tabs is 
system dependent.  Typically, the active tab is brighter than the inactive tabs. 

M20.4.2.2 63BOpen Plot… 

The Open Plot… item is used to load a pre-existing plot.  The user selects a plot file from a dialog box.  
The plot is opened in a new plot window.  The format of the plot file is described in Sect. XM20.6.8X.  The 
default extension for Javapeño plot files is .plt. 

M20.4.2.3 Open Contour Plot… 

The Open Contour Plot… item is a beta plotting capability for an undefined NEWT post-script output 
replacement. This capability is not fully defined. 

M20.4.2.4 Open Continuous Energy Data 

The Open Continuous Energy Data item opens a dialog as shown in Figure M20.4.4. The user may 
select an element defined in the Symbols list, which loads the available continuous energies by 
Temperature. The user may then select multiple temperatures and Load Selection. This action populates 
the Reaction List with relevant continuous energy given the selected library, symbol and temperatures. 
 



 

 
 M20.4.4 

 
Figure M20.4.4.  Continuous energy data dialog. 

M20.4.2.5 64BSave Current Configuration 

The Save Current Configuration option opens the XConfiguration File Editor X dialog with the current 
configuration settings loaded.  Within this dialog, the user has the option to change and save settings. 

M20.4.2.6 65BReload Configuration File 

The Reload Configuration File option loads the settings stored in the configuration file into memory.  
This will only affect new objects.  

M20.4.2.7 66BReset Configuration File 

The Reset Configuration File (over)writes the configuration file with the default settings.  The 
configuration settings are then reloaded from the file.  This will only affect new objects (such as plots).  
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M20.4.2.8 67BExport… 

The Export… menu item is used for exporting information to a datafile. 

M20.4.2.8.1 75BPlots 

If a plot is currently selected, the Export… item is used to export a plot to a graphics file.  The plot that is 
currently selected is rendered as a JPEG, TIFF, BMP, or PNG formatted file. 
 
 

 
 

Figure M20.4.5.  Export file chooser for plots. 

 
 
The format for the exported file is selected from the File Format item in the Save dialog box shown in 
XFigure M20.4.5X.  An appropriate file extension (.jpg, .tif, .bmp, or .png) is added to the filename entered 
in the Save As: field if one is not entered.  Options for formatting the files are presented after clicking the 
Save button. 
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For JPEG images, the resolution and quality of the image can be set in the following dialog shown in 
XFigure M20.4.6X.  If the Fixed Aspect Ratio option is selected, the ratio between width and height is 
maintained when one of the fields is modified. 
 
 

 
 

Figure M20.4.6.  Options for JPEG export. 

 
 
For TIFF images, the resolution and compression algorithm can be set in the dialog box shown in  
XFigure M20.4.7.  If the Fixed Aspect Ratio option is selected, the ratio between width and height is 
maintained when one of the fields is modified. 
 
 

 
 

Figure M20.4.7.  Options for TIFF export. 
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For BMP images, the resolution can be set in the dialog box shown in XFigure M20.4.8X.  Currently, only 
BMP version 3 is supported.  If the Fixed Aspect Ratio option is selected, the ratio between width and 
height is maintained when one of the fields is modified. 
 
 

 
 

Figure M20.4.8.  Options for BMP export. 

 
 
For PNG images, the resolution can be set in the dialog box shown in XFigure M20.4.9X.  If the Fixed 

Aspect Ratio option is selected, the ratio between width and height is maintained when one of the fields 
is modified. 
 
 

 
 

Figure M20.4.9.  Options for PNG export. 
 

M20.4.2.8.2 76BTables 

The Export... item is used to export a table to a tab separated text file.  A table of values from any plot 
may be created by right-clicking on a 2D plot or shift+right-clicking on a 3D plot and selecting 
“create table” from the pop-up menu. 
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Figure M20.4.10.  Export file chooser for tables. 

 
 
The format for the exported file is selected from the File Format item in the Save dialog box shown in 
XFigure M20.4.10X.  Currently, only the tab delimited text file (.txt) is supported.  An appropriate file 
extension (.txt) is added to the filename entered in the Save As:  field if one is not entered.   

M20.4.2.9 68BPage Setup 

The Page Setup menu item allows the user to configure the paper size, source, orientation, margins, and 
printer. 

M20.4.2.10 69BPrint… 

The Print… menu item allows the user to print the currently selected plot to a printer.  Color printing is 
supported. 

M20.4.2.11 70BExit 

The Exit menu item quits Javapeño. 
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M20.4.3 15BOPTIONS 

 
 

Figure M20.4.11.  Options menu. 

 
 
Four options are available in the Options menu. 
 
If Use Filenames is checked, the name of the data file will be used in place of the title on the data file for 
new files that are opened.  The name of a single file can be changed by double-clicking on its tab after it 
is opened. 
 
If Unit Lethargy is checked, the data on a new plot created with a logarithmic x-axis will be divided by 
the unit lethargy of the x variable.  This option is available for normalizing data that is computed with a 
multigroup energy structure, such as the TSUNAMI and ICSBEP sensitivity data, KMART data from 
KENO V.a and KENO-VI and XSDRNPM energy-dependent data. 
 
Lethargy is defined as 
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where Em is the maximum energy considered. 
 
For multigroup energy variables, the unit lethargy is defined as the change in lethargy across the energy 
group as 
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where Eg and Eg+1 are the maximum energies in groups g and g+1, respectively. 
 
If Fast Rendering is checked, the data on lego plots will be rendered using a faster algorithm.  
NOTE:  Fast rendering uses more memory.  If memory use is a concern, make sure this is not selected.  
This item is selected by default. 
 
If Copy Column Headings is checked, the table column headings are copied with the column data when 
copying from a table.  This is selected by default. 
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M20.4.4 16BFORMAT 

 
 

Figure M20.4.12.  Format menu. 

 
 
Three options are available under the Format menu as shown in XFigure M20.4.12. 
 
The Format Plot… item activates the XSet Plot Format X dialog for the selected plot. 
 
The Format Legend… item activates the Set Legend Format dialog for the selected plot. 
 
The Fonts… item activates the XFonts for Selected Plot X dialog. 

M20.4.5 17BWINDOW 

 
 

Figure M20.4.13.  Window menu. 

 
 
The Window menu contains four items as shown in XFigure M20.4.13X. 
 
Tile will arrange all of the open plots and tables in a grid layout. 
  
Cascade will stack all of the open plots and tables diagonally. 
  
Show All Windows bring all of the open windows to the front. 
  
Close All Plots and Tables will close all of the open plots and tables. 
  
Below these items will be a list of the open plots, tables, and windows, including the reaction list.  
Clicking on an item in this list will make the item active and bring it to the front. 
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M20.4.6 18BHELP 

The Help menu contains three items as shown in XFigure M20.4.14X. 
 
 

 
 

Figure M20.4.14.  Help menu. 

 
 
The Help item activates the online help. 
 
The Javapeño Website item opens the Javapeño website.  In Windows and Mac environments the 
website is opened in the default browser.  In a Linux environment, Javapeño tries to open the website with 
Mozilla.  In all other environments, Javapeño tries to open the website with Netscape. 
 
The About item activates an information dialog (including the version number) regarding Javapeño. 
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M20.5 5BPLOTS 

 
The generation of plots from existing data files is described in this section.  For all data types, begin by 
selecting the desired data file through the Open Dataset… item in the File menu.  When the dataset is 
opened, a list of data available for plotting will appear in the Reaction List.  Double-click on an item to 
plot it in its default format.  To add data to an existing plot, select the desired plot window, then double-
click an item in the list.  To plot the data in a new plot window when other plots are already present hold 
down the Ctrl key on the keyboard while double-clicking an item in the list or right-click on the selected 
item and select Plot in New Window from the pop-up window.  To create 2D plots with options other 
than the default options for a particular plot type, use the XNew PlotX item from the File menu to create a 
blank plot, configure the plot with the Set Plot Format dialog box, then double-click an item in the list to 
add it to the new plot. 

M20.5.1 19BTSUNAMI SENSITIVITY DATA 

TSUNAMI Sensitivity data is typically contained in data files with the extension .sdf.  Javapeño supports 
the TSUNAMI-A format generated by TSUNAMI-1D and the TSUNAMI-B format generated by 
TSUNAMI-3D.  Javapeño automatically identifies the type of file according to its contents.  The default 
settings for TSUNAMI data are logarithmic x-axis, linear y-axis and unit lethargy enabled. 
 
Once the data file is open, the list of sensitivity profiles is presented according to the nuclide-reaction 
pairs and mixture or region that the data represent.  The first data, identified only by their nuclide-reaction 
pairs, are the energy- and region-integrated sensitivity coefficients.  These data are integrated over all 
regions of the system for all mixtures that contain the nuclide.  The next series of data, identified by the 
nuclide-reaction pairs and the mixture numbers, are the mixture-integrated sensitivity coefficients.  These 
data are integrated over all regions of the problem that contain the same mixture.  If prtgeom was entered 
in the SAMS input, then data for each XSDRNPM zone of the TSUNAMI-1D data or each KENO V.a 
unit and region of the TSUNAMI-3D data are listed for each nuclide-reaction pair. 
 
In the legend, the Dataset Title as set by the XDataset OptionsX dialog is shown, followed by the Legend 

Text that is set in the Profile Information dialog box.  The energy-integrated value for the profile 
(i.e., sum over groups) is displayed.  If the profile contains both positive and negative values, the sum of 
the group-wise values that are positive and the sum of the group-wise values that are negative can be 
displayed in the legend.  Also, for region-dependent data, the region volume and the unit comment can be 
displayed. 
 
Right-clicking on an item in Reaction List and selecting Get Profile Information in the pop-up menu 
displays a dialog with some information about that profile. 

M20.5.2 20BKENO V.A AND KENO-VI DATA 

Flux and reaction rate data from KENO V.a and KENO-VI can be generated with KMART and 
KMART6, respectively.  The data file used by Javapeño is generated with the KENO3D option in 
KMART.  The format of the data files generated by KMART and KMART6 is identical and will just be 
referred to as KMART.  KMART files typically have the extension .kmt.  To begin plotting KMART 
data, select a data file using Open Dataset… from the File menu.  A list of profiles available for plotting 
will appear on the right hand side of the screen. 
 



 

 
 M20.5.2 

The list of available profiles begins with activities requested from KMART for each region of each unit 
where the requested nuclide is present in the KENO model.  These profiles are listed according to the 
nuclide ID number (nuc. ID) and the reaction MT number (Reac. ID).  Some commonly used MT 
numbers are shown in Table M20.5.1X. 
 

Table M20.5.1.  Commonly used reactions 

MT Number Reaction  

1 Total 
2 Elastic Scattering 
4 Inelastic Scattering 

16 (n,2n) 
27 Absorption 

101 Capture (non-fission absorption) 
102 n,gamma 
103 n,p 
104 n,d 
105 n,t 
106 n,he-3 
107 n,alpha 
452 nubar 

1018 chi 
 
 
The flux is identified as Nuc. ID 99 and Reac. ID 1099, which are listed as the last profiles in the list.  A 
final profile is given for the region-integrated flux identified as Unit 0 and Reg. 0.  This final profile is the 
flux summed over all regions in the model. 
 
The Integral Value identified in the legend text is the sum over groups for the particular profile.  For the 
region-integrated flux, the integral value is not available on the data file and is listed as 0.0 in Javapeño. 

M20.5.3 21BXSDRNPM DATA 

Data from XSDRNPM are written on one to three data files.  These files are the input dump file (.idf), the 
balance table file (.btf) and the activities file (.acf).   The .idf file contains the problem definition; the .btf 
file contains fluxes, currents and sources; and the .acf file contains user-requested activities. 
 
To view the data contained in these files, begin by opening the .idf file with Open Dataset… from the 
File menu.  Javapeño expects the .btf and .acf files to be present in the same directory with the same root 
name as the .idf file.  For example, if the .idf file is called mydata.idf, Javapeño expects the .btf file to be 
mydata.btf and the .acf file to be mydata.acf.  If Javapeño cannot find these files, a dialog box will appear 
where the user can locate them manually.  If one file cannot be located, its data will not be available for 
plotting.  If neither the .btf nor the .acf file can be located, no data will be available for plotting. 
 
When both the .btf and .acf files are available, the data from the .acf file appears first in the list of profiles 
available for plotting.  Activities by interval for each nuclide-reaction pair requested from XSDRNPM are 
listed first.  These data represent the activity per unit volume for each interval of the computational mesh.  
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The next series of data are the activities by zone.  These data represent the activity per unit volume of 
each material zone defined in the system model.  If one of these datasets is used to create a new plot 
(when no plots are open, when the Ctrl+double-click is used, or when Plot in New Window is selected 
in the pop-up menu), the default settings for the plot are linear x- and y-axes and no lethargy. 
 
The next series of data in the list of profiles available for plotting are from the .btf file.  The profiles that 
can be included in the .btf file are fixed source, fission source, absorption rate, total leakage, fission rate, 
flux, <n,2n> rate, buckling loss, right current and left current.  These profiles are identified for each 
material zone in the system model.  Often many of these profiles only contain zero data, and a warning 
message will appear if the user tries to plot a zero profile.  For example, the fission rate in a zone without 
fissile material is zero.  If one of these datasets is used to create a new plot (when no plots are open, when 
the Ctrl+double-click is used, or when Plot in New Window is selected in the pop-up menu), the default 
settings for the plot are logarithmic x- and y-axes and use lethargy. 

M20.5.4 22BSMORES DATA 

SMORES data are output in two files.  The .plotd file contains densities, masses and k-eff by iteration.  
The .plote file contains effectiveness functions.  To open either file, select the file with Open Dataset… 
from the File menu.  When opening a .plotd file, the reaction list contains densities as a function of 
position of each iteration followed by a summary of Mass by Iteration and K-eff by Iteration.  When 
opening a .plote file, the reaction list contains effectiveness functions for each iteration. 
 
If a SMORES dataset is used to create a new plot (when no plots are open, when the Ctrl+double-click is 
used, or when Plot in New Window is selected in the pop-up window), the default settings for the plot 
are linear x- and y-axes and no lethargy. 

M20.5.5 23BICSBEP SENSITIVITY DATA 

Several sets of sensitivity data are distributed with the International Handbook of Evaluated Criticality 
Safety Benchmark Evaluations DVD.  In the 2005 DVD (the latest version tested with Javapeño), these 
data are available on the DVD in the directory Dice/data/sensitivity/HEU and Dice/data/sensitivity/PU.  
In the Open Dataset… dialog, choose the File Format of All Files.  Because the format of these data 
files do not allow for a title, the File Title is always set to ICSBEP.  The use of the Use Filenames items 
in the Options menu is recommended to obtain a more descriptive title.  Some profiles listed on these 
data files (such as H FISSION) contain only zeros.  Although these data are listed by Javapeño, zero data 
cannot be plotted, and a warning message will appear. 
 
The energψ structure of the ICSBEP data is contained in a separate data fiλe that is caλλed “eνergies” and 

is in the Dice/data/sensitivity directory on the 2005 DVD.  Javapeño relies on this file existing one level 
above the directory containing the sensitivity data (e.g., HEU).  If this file is moved or renamed, ICSBEP 
data cannot be processed.  Javapeño assumes that only 30 energy groups are present for ICSBEP 
sensitivity data. 
 
Right-clicking on an item in the list of data available for plotting and selecting Profile Information 
displays a dialog with some information about that profile. 
 
If an ISCBEP dataset is used to create a new plot (when no plots are open, when the Ctrl+double-click is 
used, or when selecting Plot in New Window in the pop-up menu), the default settings for the plot are 
logarithmic x-axis, linear y-axis, and unit lethargy is enabled. 
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M20.5.6 24BCROSS-SECTION-COVARIANCE DATA 

Javapeño supports plotting multigroup cross-section-covariance data in the COVERX binary format.  By 
default there is no extension on the cross-section-covariance data files.  The 44groupcov cross-section-
covariance data file present in the scale6.0/data directory and is documented in Sect. HM19H of the SCALE 
manual.  To open the file, select the file with Open Dataset… from the File menu.  A list of reactions 
wiλλ be dispλayed with each reaction forµ atted as “NUCLIDE_SYMBOL_1-MT_NAME_1 to 
NUCLIDE_SYMBOL_2-MT_NAME_2”. 
 
A plot of the energy-group to energy-group cross-section covariance data is created by double-clicking on 
an entry in the Reaction List.  When a new plot is created, the covariance matrix will appear as a 3D plot, 
and the standard deviation will appear below the 3D plot as a 2D plot.  Right-clicking on an item in the 
Reaction List provides a pop-up menu with many options including plotting the standard deviation 
without the covariance matrix as a function of energy or energy group. 

M20.5.7 25BCROSS-SECTION DATA 

Javapeño can plot cross-section data from AMPX master or working binary data libraries.  By default 
there is no extension on the AMPX libraries.  Javapeño can, in most cases, detect whether the library is in 
the master or working format.  If Javapeño cannot determine the type of library, a prompt will be 
displayed asking how the file should be treated.  To open the file, select the file with Open Dataset… 
from the File menu.  A Reaction List will be displayed in tree format.  The reactions are formatted as 
“MIXTURE NUCLIDE_SYMBOL MT_NAME TEMPERATURE_IN_KELVIN LEGENDRE_ORDER.”  If 

certain information, such as temperature, is not available, then it is not included in the reaction label.  The 
grouping of the tree is explained in Sect. XM20.9.1X. 
 
Double-clicking on an item within the tree will either open the next level down in the tree, or at the lowest 
level, will plot the data.  Reaction cross sections are visualized as 2D plots and transfer arrays are 
visualized as 3D plots.  Right-clicking on items in the Reaction List will provide a pop-up menu with 
more options. 

M20.5.8 26BGENERAL 2D PLOT DATA 

Javapeño will open and render 2D plots in a general plot format.  The support of a general format is 
useful for viewing 2D data from other sources.  The format is defined by a series of keywords and data 
values.  A 2D plot file contains data for a single plot and may contain multiple datasets.  Options for the 
plot format are entered first followed by options and values for each dataset.  Once a plot is loaded, it can 
be customized using the interactive features of Javapeño. 

../../../AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.IE5/U95ZNLE6/M19covlib_rev1.doc
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The options for the plot are given below in XTable M20.5.2.  Default values are shown in bold, where 
applicable. 
 

Table M20.5.2.  Plot options keywords for general 2D datafile 

Identifier Values Description 

marks: none, points, dots, various Places a marker on the data point for all datasets. 

lines: on, off Connects data points with lines for all datasets. 

impulses: on, off Draws lines from the data point to the x-axis for log plots 
or to y=0 for linear plots for all datasets. 

bars: off 

width, offset 
If defined with width and offset, a bar chart will be 
produced.  If off, a line plot will be produced. 

movelegend: on, off Activates automoving legend that tries to move away 
from data points. 

titletext: title_text Prints title_text at the top of the plot. 

xlabel: x_axis_label Prints x_axis_label by the x-axis. 

ylabel y_axis_label Prints y_axis_label by the y-axis. 

yrange: y_min, y_max Minimum and maximum values for y-axis. 

xrange: x_min, x_max Minimum and maximum values for x-axis. 

xticks: “label1” x1, “label2” x2, etc Names and values for tick marks for the x-axis.  Only 
necessary when overriding the use of data values on the 
x-axis. 

yticks: “label1” ψ1, “label2” ψ2, etc Names and values for tick marks for the y-axis.  Only 
necessary when overriding the of data values on the y-
axis. 

xlog: on, off Set x-axis as logarithmic. 

ylog: on, off Set y-axis as logarithmic. 

grid: on, off Show x- and y-gridlines. 

xgrid: on, off Show x-gridlines. 

ygrid: on, off Show y-gridlines. 

moregrid: on, off Show more gridlines, if x- or y-gridlines are shown. 

color: on, off Use color in the graph. If off, graph is black and white. 

linewidth: line_width Default line width for profiles added to the plot. 

dash: on, off Draw lines between data points as dashed lines. 
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A dataset begins with the identifier dataset: followed by the text for the legend for this dataset.  Options 
can be set for the current dataset using some of the same identifiers used to set options for the plot.  Once 
the identifier dataset: is entered, the options apply only to the current dataset.  The available identifiers 
are listed below in XTable M20.5.3. 
 
 

Table M20.5.3.  Dataset keywords for general 2D datafile 

Identifier Values Description 

dataset: legend_text Begins a new dataset with legend_text for the legend.  
Note that ?? in the legend_text will create a line 
break.  Also, if the legend of the current dataset 
matches the legend of the previous data set by all 
except the last 8 characters, only the last 8 characters 
of the current dataset are printed.  This is for log  
y-axis data that are identified with the same legend, 
except oνe legeνd ends iν “Positive” and the other 

ends in “Negative”. 

marks: none, points, dots, various Places a marker on the data point for this dataset. 
Overrides values set in the plot options section, which 
is the default for all datasets. 

lines: on, off Connects data points with lines for this dataset.  
Overrides values set in the plot options section, which 
is the default for all datasets. 

impulses: on, off Draws lines from the data point to the x-axis for log 
plots or to y=0 for linear plots for this dataset.  
Overrides values set in the plot options section, which 
is the default for all datasets. 

linewidth: line_width Sets the line width for the current dataset. 

datasetcolor: hex number for HTML color 
preceded by 0x (e.g., 
datasetcolor: 0xff0000 sets the 
color for the current dataset to 
red) Default 0x000000 (black) 

Sets color for this dataset.  Color is only used if 
“color: oν” is entered in the pλot optioνs.  See Table 

M18.B.1 for HTLM colors. 

 
 
Once options for the dataset are entered, the data values for the current dataset can be entered using the 
identifiers given below in XTable M20.5.4.  If no identifier is given, draw: is assumed for data entry. 
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Table M20.5.4.  Data value keywords for general 2D datafile 

Identifier Values Description 

draw: x, y, y_eb_low, y_eb_high Defines a point on the plot at location (x,y).  
y_eb_low and y_eb_high are optional arguments that 
define the low and high points for an error bar.  If 
“liνes” is set to oν, this point will be coννected to the 

previous and next point.  

move: x, y, y_eb_low, y_eb_high Defines a point on the plot at location (x,y).  
y_eb_low and y_eb_high are optional arguments that 
define the low and high points for an error bar.  This 
point will not be connected to the next or previous 
point uνless “λines” is subsequentlψ set to oν. 

skip: x, y, y_eb_low, y_eb_high Defines a point on the plot at location (x,y).  
y_eb_low and y_eb_high are optional arguments that 
define the low and high points for an error bar.  This 
point will never be connected to the next or previous 
point even if “liνes” is set to oν. 

hist: x, y, y_eb_low, y_eb_high, 
x_min, x_max 

Defines a point on the plot at location (x,y).  
y_eb_low and y_eb_high  define the low and high 
points for an error bar extending from the point (x,y).  
If y_eb_low and y_eb_high are both zero, the error 
bar will not be drawn.  x_min and x_max define the x-
range where this data is valid and a line is drawn from 
x_µ iν to x_µ ax with a height of ψ.  If “liνes” is set to 

on, this point will be connected to the previous and 
next point from the points (x_min, y) and (x_max,y) 

jump: x,y Repositions the plot pointer to (x,y).  This is an 
invisible point that will never have a line or a mark. 

change: x,y Reposition the plot pointer to (x,y).  This point will 
νever have a µ ark, but will have a line if “liνes” is set 

to on. 
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Some examples of .plt files are given on the following pages. 

M20.5.8.1 71BSensitivity Plot 

The data file for an example sensitivity plot is shown in XFigure M20.5.1. 
 

xlog: on 

DataSet: h-1 total?? a = 0.220288 +/- 0.01991497?? osc = -0.07603897 +/- 0.01586998 

datasetcolor: 0x0000ff 

jump: 1.00E-05, -3.73E-04 

hist: 5.24E-04, -3.73E-04, -4.96E-04, -2.49E-04, 3.00E-03, 1.00E-05 

hist: 4.91E-03, -6.67E-03, -8.75E-03, -4.60E-03, 7.50E-03, 3.00E-03 

hist: 8.69E-03, -1.08E-02, -1.75E-02, -4.00E-03, 1.00E-02, 7.50E-03 

hist: 1.65E-02, -2.59E-02, -3.32E-02, -1.85E-02, 2.53E-02, 1.00E-02 

hist: 2.76E-02, -4.60E-02, -6.95E-02, -2.26E-02, 3.00E-02, 2.53E-02 

hist: 3.48E-02, -2.79E-02, -4.93E-02, -6.43E-03, 4.00E-02, 3.00E-02 

hist: 4.48E-02, -3.86E-02, -6.41E-02, -1.31E-02, 5.00E-02, 4.00E-02 

hist: 5.94E-02, -2.59E-02, -4.69E-02, -4.91E-03, 7.00E-02, 5.00E-02 

hist: 8.41E-02, -8.70E-03, -2.60E-02, 8.61E-03, 1.00E-01, 7.00E-02 

hist: 1.23E-01, -9.97E-03, -2.16E-02, 1.65E-03, 1.50E-01, 1.00E-01 

hist: 1.74E-01, 1.81E-03, -6.76E-03, 1.04E-02, 2.00E-01, 1.50E-01 

hist: 2.12E-01, 3.48E-03, -6.03E-03, 1.30E-02, 2.25E-01, 2.00E-01 

hist: 2.37E-01, 4.46E-03, -4.77E-03, 1.37E-02, 2.50E-01, 2.25E-01 

hist: 2.62E-01, -2.33E-03, -1.15E-02, 6.79E-03, 2.75E-01, 2.50E-01 

hist: 2.99E-01, 1.34E-03, -5.56E-03, 8.24E-03, 3.25E-01, 2.75E-01 

hist: 3.37E-01, -1.67E-03, -1.11E-02, 7.72E-03, 3.50E-01, 3.25E-01 

hist: 3.62E-01, 2.74E-03, -6.71E-03, 1.22E-02, 3.75E-01, 3.50E-01 

hist: 3.87E-01, 1.72E-03, -8.11E-03, 1.16E-02, 4.00E-01, 3.75E-01 

hist: 5.04E-01, 4.39E-03, 2.26E-04, 8.56E-03, 6.25E-01, 4.00E-01 

hist: 7.98E-01, 5.74E-03, 1.65E-03, 9.83E-03, 1.00E+00, 6.25E-01 

hist: 1.35E+00, 7.73E-03, 3.94E-03, 1.15E-02, 1.77E+00, 1.00E+00 

hist: 2.33E+00, 1.01E-02, 6.21E-03, 1.41E-02, 3.00E+00, 1.77E+00 

hist: 3.81E+00, 1.02E-02, 6.13E-03, 1.44E-02, 4.75E+00, 3.00E+00 

hist: 5.35E+00, 2.20E-02, 1.71E-02, 2.69E-02, 6.00E+00, 4.75E+00 

hist: 7.00E+00, 9.22E-02, 8.89E-02, 9.55E-02, 8.10E+00, 6.00E+00 

hist: 9.02E+00, 2.43E-02, 1.92E-02, 2.94E-02, 1.00E+01, 8.10E+00 

hist: 1.82E+01, 2.54E-02, 2.30E-02, 2.79E-02, 3.00E+01, 1.00E+01 

hist: 5.81E+01, 2.35E-02, 2.09E-02, 2.61E-02, 1.00E+02, 3.00E+01 

hist: 2.64E+02, 1.46E-02, 1.24E-02, 1.68E-02, 5.50E+02, 1.00E+02 

hist: 1.44E+03, 1.48E-02, 1.24E-02, 1.72E-02, 3.00E+03, 5.50E+02 

hist: 8.07E+03, 1.11E-02, 8.59E-03, 1.36E-02, 1.70E+04, 3.00E+03 

hist: 2.07E+04, 1.26E-02, 7.15E-03, 1.81E-02, 2.50E+04, 1.70E+04 

hist: 5.41E+04, 9.62E-03, 7.07E-03, 1.22E-02, 1.00E+05, 2.50E+04 

hist: 2.16E+05, 1.47E-02, 1.21E-02, 1.73E-02, 4.00E+05, 1.00E+05 

hist: 6.17E+05, 3.25E-02, 2.88E-02, 3.62E-02, 9.00E+05, 4.00E+05 

hist: 1.13E+06, 4.15E-02, 3.74E-02, 4.55E-02, 1.40E+06, 9.00E+05 

hist: 1.61E+06, 3.08E-02, 2.71E-02, 3.45E-02, 1.85E+06, 1.40E+06 

hist: 2.09E+06, 2.35E-02, 2.04E-02, 2.67E-02, 2.35E+06, 1.85E+06 

hist: 2.42E+06, 2.17E-02, 1.69E-02, 2.65E-02, 2.48E+06, 2.35E+06 

hist: 2.73E+06, 1.78E-02, 1.53E-02, 2.03E-02, 3.00E+06, 2.48E+06 

hist: 3.83E+06, 1.50E-02, 1.38E-02, 1.62E-02, 4.80E+06, 3.00E+06 

hist: 5.58E+06, 8.84E-03, 8.18E-03, 9.50E-03, 6.43E+06, 4.80E+06 

hist: 7.28E+06, 1.22E-03, 8.54E-04, 1.59E-03, 8.19E+06, 6.43E+06 

hist: 1.32E+07, -9.57E-06, -5.77E-05, 3.86E-05, 2.00E+07, 8.19E+06 
 

Figure M20.5.1.  Sensitivity plot data file. 
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The plot produced by this plot file is shown in XFigure M20.5.2X. 
 

 
 

Figure M20.5.2.  Sample Javapeño sensitivity plot. 
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M20.5.8.2 72BLine Plot 

An example line plot generated from KENO V.a k-eff by generation run data is defined by the data file 
given in XFigure M20.5.3X. 
 
 

TitleText:  K-eff vs. Generation 

XLabel: Generation 

YLabel: k-eff 

xlog: off 

ylog: off 

marks: off 

movelegend: on 

 

dataset: k-eff by generation run 

Lines: on 

datasetcolor: 0x0000ff 

 

1,1,1,1 

2,1,1,1 

3,0.995831,0.995831,0.995831 

4,0.990162,0.98449303,0.99583097 

5,0.982489,0.97414723,0.99083077 

6,0.975836,0.96694467,0.98472733 

7,0.979603,0.9694688,0.9897372 

8,0.98598,0.9678554,1.0041046 

9,0.982253,0.9721931,0.9923129 

10,0.98449,0.97560403,0.99337597 

11,0.988721,0.97965268,0.99778932 

12,0.990465,0.9725904,1.0083396 

13,0.994231,0.979803,1.008659 

14,0.996856,0.979196,1.014516 

15,0.99596,0.9825611,1.0093589 

16,0.996749,0.9830748,1.0104232 

17,0.993585,0.9814489,1.0057211 

18,0.990633,0.9774795,1.0037865 

19,0.993507,0.9826934,1.0043206 

20,0.993016,0.9829382,1.0030938 

21,0.995658,0.98614136,1.00517464 

22,0.994564,0.98677078,1.00235722 

23,0.997075,0.98827843,1.00587157 

24,0.997633,0.98935684,1.00590916 

25,0.997886,0.98992033,1.00585167 

26,0.998038,0.9904315,1.0056445 

27,0.998964,0.99159651,1.00633149 

28,0.998445,0.99138049,1.00550951 

29,0.999152,0.99223025,1.00607375 

30,1.00034,0.99339985,1.00728015 

31,1.00258,0.99493714,1.01022286 

32,1.00219,0.99504347,1.00933653 

33,1.00223,0.99533197,1.00912803 

34,1.00315,0.99610211,1.01019789 

35,1.00357,0.99655947,1.01058053 

36,1.00342,0.99666927,1.01017073 

37,1.00314,0.99665846,1.00962154 

38,1.00288,0.99663197,1.00912803 

Figure M20.5.3.  Line plot data file. 
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39,1.0023,0.99615942,1.00844058 

40,1.00339,0.99759181,1.00918819 

41,1.00371,0.99805739,1.00936261 

42,1.00344,0.99800295,1.00887705 

43,1.00341,0.99811772,1.00870228 

44,1.00273,0.99763626,1.00782374 

45,1.00273,0.99776521,1.00769479 

46,1.00285,0.99802548,1.00767452 

47,1.003,0.99828543,1.00771457 

48,1.0033,0.99866753,1.00793247 

49,1.00334,0.99880951,1.00787049 

50,1.00412,0.99955107,1.00868893 

51,1.00397,0.99953071,1.00840929 

52,1.00456,1.00008076,1.00903924 

53,1.00448,1.00010357,1.00885643 

54,1.00404,0.99978432,1.00829568 

55,1.00397,0.99979005,1.00814995 

56,1.00423,1.00016031,1.00829969 

57,1.00431,1.00031428,1.00830572 

58,1.00439,1.00046234,1.00831766 

59,1.00419,1.0003387,1.0080413 

60,1.00412,1.00033595,1.00790405 

61,1.00452,1.00081389,1.00822611 

62,1.00517,1.00140307,1.00893693 

63,1.00547,1.00166462,1.00927538 

64,1.0057,1.00189018,1.00950982 

65,1.00583,1.00206244,1.00959756 

66,1.00587,1.00216041,1.00957959 

67,1.00633,1.00262795,1.01003205 

68,1.00643,1.00277076,1.01008924 

69,1.00633,1.00274331,1.00991669 

70,1.00649,1.00295542,1.01002458 

71,1.00688,1.00331199,1.01044801 

72,1.00755,1.00369375,1.01140625 

73,1.00738,1.00369252,1.01106748 

74,1.00757,1.00390349,1.01123651 

75,1.00763,1.00399902,1.01126098 

76,1.00754,1.00399221,1.01108779 

77,1.00792,1.00424025,1.01159975 

78,1.00766,1.00410748,1.01121252 

79,1.0075,1.00400113,1.01099887 

80,1.00761,1.0041586,1.0110614 

81,1.00756,1.00414852,1.01097148 

82,1.00792,1.00450475,1.01133525 

83,1.00776,1.00439273,1.01112727 

84,1.00777,1.00444697,1.01109303 

85,1.00748,1.00441631,1.01054369 

86,1.00715,1.00384624,1.01045376 

87,1.0072,1.00394278,1.01045722 

88,1.00759,1.00460994,1.01057006 

89,1.00768,1.00471954,1.01064046 

90,1.00797,1.00498187,1.01095813 

91,1.00768,1.00475035,1.01060965 

92,1.00777,1.00487314,1.01066686 

93,1.00776,1.00489528,1.01062472 

94,1.00787,1.00503251,1.01070749 

95,1.00781,1.00500562,1.01061438 

96,1.00783,1.00505635,1.01060365 

97,1.00803,1.00528245,1.01077755 

98,1.00829,1.00553827,1.01104173 

99,1.0084,1.00565604,1.01114396 

100,1.00808,1.0053899,1.0107701 

 

dataset: Average k-eff 

Lines: on 

datasetcolor: 0xff0000 

 

1,1 

100,1 

Figure M20.5.3.  Line plot data file (continued). 
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The plot produced by this data file is shown in XFigure M20.5.4X. 
 

 
Figure M20.5.4.  Sample Javapeño line plot. 
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M20.5.8.3 73BBar Chart 

An example bar chart data file generated with KENO V.a data for the frequency of k-eff is defined by the 
data file given in XFigure M20.5.5X.  Note that the XTicks: data actually appear on one line in the file, 
although it does not display as such here. 
 
 
TitleText: Frequency of k-eff by Generation                    

XTicks:  0.7129 1, 0.7362 2, 0.7595 3, 0.7828 4, 0.8061 5, 0.8294 6, 0.8527 7, 0.8760 8, 0.8993 

9, 0.9227 10, 0.9460 11, 0.9693 12, 0.9926 13, 1.0159 14, 1.0392 15, 1.0625 16, 1.0858 17, 1.1091 

18, 1.1324 19, 1.1558 20, 1.1791 21, 1.2024 22, 1.2257 23, 1.2490 24 

XLabel: k-eff                          

YLabel: frequency                      

Marks: none                           

Lines: off                            

Bars: 0.5, 0.1       

Moregrid: off                 

 

DataSet: Generations 752 to     1000       

datasetcolor: 0x0000ff     

 

           1,            0 

           2,            1 

           3,            0 

           4,            3 

           5,            5 

           6,            4 

           7,            6 

           8,           12 

           9,           14 

          10,           17 

          11,           23 

          12,           28 

          13,           21 

          14,           33 

          15,           21 

          16,           22 

          17,           14 

          18,            8 

          19,            2 

          20,            5 

          21,            1 

          22,            2 

          23,            5 

          24,            2 

Figure M20.5.5.  Bar chart data file. 
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DataSet: Generations 503 to     1000      

datasetcolor: 0xff0000      

 

           1,            0 

           2,            1 

           3,            0 

           4,            4 

           5,            7 

           6,           13 

           7,           13 

           8,           25 

           9,           31 

          10,           39 

          11,           47 

          12,           50 

          13,           41 

          14,           56 

          15,           37 

          16,           43 

          17,           29 

          18,           21 

          19,           10 

          20,           10 

          21,            7 

          22,            4 

          23,            7 

          24,            2 

 

DataSet: Generations 255 to     1000  

datasetcolor: 0x00ff00          

 

           1,            0 

           2,            3 

           3,            4 

           4,            6 

           5,            9 

           6,           20 

           7,           25 

           8,           34 

           9,           47 

          10,           67 

          11,           61 

          12,           67 

          13,           63 

          14,           75 

          15,           64 

          16,           60 

          17,           47 

          18,           35 

          19,           18 

          20,           13 

          21,           11 

          22,            7 

          23,            7 

          24,            2 
 

Figure M20.5.5.  Bar chart data file (continued). 
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DataSet: Generations 6 to     1000           

datasetcolor: 0xffa500 

 

           1,            1 

           2,            3 

           3,            4 

           4,            9 

           5,            9 

           6,           23 

           7,           38 

           8,           45 

           9,           58 

          10,           87 

          11,           80 

          12,          103 

          13,           82 

          14,           91 

          15,           95 

          16,           84 

          17,           58 

          18,           45 

          19,           24 

          20,           17 

          21,           14 

          22,           13 

          23,            8 

          24,            2 
 

Figure M20.5.5.  Bar chart data file (continued). 
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The plot produced by this file is shown in XFigure M20.5.6. 
 
 

 
 

Figure M20.5.6.  Sample Javapeño bar chart. 

 

M20.5.9 27BGENERAL 3D PLOT DATA 

Javapeño will open and render 3D plots in a general plot format.  The support of a general format is 
useful for viewing 3D data from other sources.  The format is defined by a series of keywords and data 
values.  A 3D plot file contains data for a single plot and may contain multiple datasets.  Once a plot is 
loaded, it can be customized using the interactive features of Javapeño. 
 
The keywords for the General 3D files are shown in XTable M20.5.5.  All keywords are required. 
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Table M20.5.5.  Keywords for general 3D datafile 

Identifier Values Description 

ft: file_title Sets the label that will appear in the reaction list tab.  Only 
one file title is allowed per file. 

dt: data_title Sets the label that will appear in the reaction list for a single 
dataset.  Each dataset will have a data title. 

xl: x_axis_label Sets the label for the x axis. 

yl: y_axis_label Sets the label for the y axis. 

zl: z_axis_label Sets the label for the z axis. 

xx: maximum x axis value The maximum value for the x axis. 

xn: minimum x axis value The minimum value for the x axis. 

yx: maximum y axis value The maximum value for the y axis. 

yn: minimum y axis value The minimum value for the y axis. 

enddata n/a Ends the dataset.  NOTE:  enddata does NOT have a colon. 
 
 
The following rules apply to all General 3D datafiles: 
 

1. All tags are required.  Each tag, except enddata, must have a value.  Use a space if you do not 
want a label for the file title, dataset title, or axis labels. 

2. The file must start with ft:. 
3. Each dataset must start with dt:. 
4. The first three tags in a dataset must be the axis labels, but they may be listed in any order.  Each 

label can only appear once in a dataset. 
5. The next four tags must be the x-axis and y-axis ranges, but they may be listed in any order.  Each 

tag may only occur once per dataset.  Both the minimum and maximum values must be greater 
than 0. 

6. Only one data point may be listed on a line.  Data points must be entered in the following format:  
x_bin y_bin z_value.  X_bin must be the range [xn,xx].  Y_bin must be in the range [yn,yx]. 

7. A dataset must end with enddata.  NOTE:  enddata does NOT have a colon. 
8. Repeat rules 3–7 for each dataset in the file. 
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M20.5.9.1 74BExample General 3D Datafile and Plot 

An example general 3D datafile is shown in XFigure M20.5.7X.  With the first and second datasets shown in 
Figures XM20.5.8– M20.5.9, respectively. 
 
 

ft: Example General 3D file                    

dt: Dataset 1 

xl:  X Axis Label 

yl:  Y Axis Label 

zl:  Z Axis Label 

xn: 1 

xx: 3 

yn: 5 

yx: 15 

1 6 -4.055744304810888 

1 11 -4.43143902041877 

2 11 -5.435204707046975 

1 10 7.728216904501456 

2 14 4.160148434 

1 6 1.2486732396150281 

1 5 -2.4786799019574234 

2 5 9.678322479503629 

enddata 

dt: Dataset 2 

xl:  Another X Axis Label 

yl:  Another Y Axis Label 

zl:  Another Z Axis Label 

xn: 1 

xx: 10 

yn: 2 

yx: 5 

1 2 1.3617897533080401 

8 2 8.967110372110565 

3 5 -7.326660910564604 

10 2 -1.7921810326430053 

6 2 -2.105685751801301 

7 3 -7.5397161376445 

enddata 
 

Figure M20.5.7.  Example 3D datafile. 
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Figure M20.5.8.  Dataset 1 from example 3D datafile. 
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Figure M20.5.9.  Dataset 2 from example 3D datafile. 
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M20.6 6BCUSTOMIZED PLOTS 

 
Features for customizing plots are described in this section.  A plot can be resized by resizing the window 
that contains it. 

M20.6.1 28BSET PLOT FORMAT 

The Set Plot Format dialog box is available for both 2D and 3D plots using four panels that set several 
options for the selected plot.  The 2D dialog box can be activated by double-clicking on a 2D plot, outside 
of the legend.  Both versions can be activated by selecting Format Plot… from the Format menu.  Also, 
specific panels can be accessed with the pop-up menu accessible by right-clicking on a 2D plot or 
shift+right-clicking on a 3D plot. 

M20.6.2 29BAXES (2D) 

The Axes panel, shown in Figure M20.6.1X, allows the current 2D plot axes to be formatted.  The x- and 
y-axes can be set as logarithmic (otherwise they are linear) and the division by unit lethargy can be 
selected.  X- and y-axis grid lines can be turned on if selected.  More Gridlines displays minor marks. 
 
 

 
 

Figure M20.6.1.  Plot axes formatting dialog for 2D plots. 
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M20.6.3 30BPLOT OPTIONS (2D) 

The Plot Options panel, shown in XFigure M20.6.2X, is used to set several display options for the selected 
2D plot.  Options with text fields are updated after the user presses Enter.  All other options are updated 
immediately. 
 
 

 
 

Figure M20.6.2.  Plot options formatting for 2D plots. 

 
 
Stems:  Draw lines from the data point to the x-axis for a logarithmic y-axis or to y=0 for a linear y-axis. 
 
Line Width:  Used to set the width for lines on the plot.  Press Enter or Return to update the plot after 
changing the line width. 
 
Errors Bars:  Hide/show error bars, if available. 
 
Marks:  Add marks of selected style to data points in plot. 
 
Auto Move Legend:  Legend placement will automatically vary to avoid interfering with the displayed 
data. 
 
Connect:  Data points are connected with lines. 
 
Assign Dashes:  Assign dash values to all profiles in the plots according to their index in the plot.  If there 
are more than 11 profiles in the plot then the pattern sequence will restart. 
 
Reset Dashes:  Sets all profiles to their initial dash state, which is a solid line. 
 
Use Dashes:  Lines are drawn with dashed patterns.  Dash patterns for data can be customized in the 
Profile Information dialog accessible by double-clicking or right-clicking in the legend. 
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Text Color:  Allows the user to change the color of text in the plot.  Colors for data can be customized in 
the Profile Information dialog accessible by double-clicking in the legend. 
 
Border Color:  Allows the user to change the color of the border around a plot. 

M20.6.4 31BPLOT OPTIONS (3D) 

The Plot Options panel, shown in Figure M20.6.3X, accessible from the Format µ enu “Format Plot….” 

item or by shift+right-clicking on the plot and selecting Format Plot from the pop-up menu, is used to set 
several display options for the selected 3D plot.  Options with text fields are updated after the user presses 
Enter.  All other options are updated immediately. 
 
 

 
 

Figure M20.6.3.  Plot options formatting for 3D plots. 

 
 
Plot Type:  Select whether to display the 3D plot in either Lego (block) or Surface (contour) format.  
Lego Plot is the default type. 
 
Correlation Coefficient (COVERX only):  Display the Correlation Coefficient of the current plot.  The 
correlation coefficient will be displayed in the current Plot Type format.  This is turned off by default. 
 
Standard Deviation (COVERX only):  Display the Standard Deviation of the plot.  The standard 
deviation is displayed in a 2D plot that is attached to the 3D plot.  If Correlation Coefficient is selected, 
the standard deviation is computed from the covariance data and not from the correlation coefficient data.  
The standard deviation is displayed by default. 
 
Normalized Probability (AMPX P0 only):  Display the normalized probability of the current plot.  It will 
be displayed in the current Plot Type.  This is turned off by default. 
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Avg. Cosine of Scattering Angle (AMPX P1 only):  Display the average cosine of the scattering angle for 
the current plot.  It will be displayed in the current Plot Type.  This is turned off by default. 
 
Plot View:  Select the projection policy for the current plot.  The default projection policy is perspective. 
 
Set Transparency Level:  Sets the transparency level for the current plot.  Pulling the slider to the right 
increases the transparency of the plotted data (Surface or Lego).   
 
Text Color:  Allows the user to change the color of text in the plot. 
 
Border Color:  Allows the user to change the color for the border of the plot. 

M20.6.5 32BPLOT TITLES (2D) 

The Plot Titles panel, shown in XFigure M20.6.4X, allows for customized titles in the selected 2D plot 
window.  The fonts used for these titles can be set in the XFonts for Selected Plot X dialog.  Pressing Enter or 
Return on the keyboard after entering text in one of the fields will cause the plot to update with the 
modified text. 
 
 

 
 

Figure M20.6.4.  Plot titles formatting for 2D plots. 

 
Title:  Title displayed at the top of the plot. 
 
X Label:  Label for x-axis. 
 
Y Label:  Label for y-axis. 
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M20.6.6 33BPLOT TITLES (3D) 

The Plot Titles panel, shown in XFigure M20.6.5X, allows for customized titles in the selected 3D plot 
window.  Pressing Enter or Return on the keyboard after entering text in one of the fields will cause to 
plot to update with the modified text. 
 
 

 
Figure M20.6.5.  Plot titles formatting for 3D plots. 

 
 
X Label:  Label for x-axis. 
 
Y Label:  Label for y-axis. 
 
Z Label:  Label for z-axis. 
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M20.6.7 34BPLOT RANGES (2D) 

The ranges of displayed data can be set for the x- and y-axes.  Pressing Enter or Return on the keyboard 
after modifying the data in any of the fields will cause the plot to update with the modified values. 
 
 

 
Figure M20.6.6.  Plot ranges formatting for 2D plots. 

 
 
In the above dialog, the x-axis is logarithmic and the y-axis is linear.  In the case of a logarithmic axis, the 
values entered are the exponents for the base 10 value, i.e. x in 10x, corresponding to the minimum and 
maximum values for the range of the particular axis.  For a linear axis, the values entered are the actual 
values for the minimum and maximum of the range.  The ranges of the displayed data can also be set by 
zooming. Pressing Fill Plot resets the axes to the actual [Minimum, Maximum] ranges. 

M20.6.8 35BPLOT RANGES (3D) 

The ranges of displayed data can be set for the x-, y-, and z- axes with the Ranges dialog shown in  
XFigure M20.6.7X.  The plot scale can also be set.  The scale value is a straight multiplier for the plot data 
and is an inverse multiplier for the plot text.  Pressing Enter or Return on the keyboard after modifying 
the data in any of the fields will cause the plot to update with the modified values. Pressing Fill Plot 
resets the axes to the actual [Minimum, Maximum] ranges. 
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Figure M20.6.7.  Plot ranges formatting for 3D plots. 

 
 

M20.6.9 36BPLOT ROTATION (3D ONLY) 

The Rotation panel, shown in XFigure M20.6.8X, allows for customized rotation of a 3D plot.  Pressing 
Enter or Return on the keyboard after entering text in one of the fields will cause to plot to update with 
the modified text. 
 
 

 
Figure M20.6.8.  Plot rotation formatting for 3D plots. 
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The rotation for an axis can be set by explicitly setting a value in the text field or by clicking the 
appropriate button. 
 
Current X Rotation:  Current rotation of the plot on the x-axis in degrees.  Entering a value into this text 
field, and pressing Enter, will set the x-axis rotation of the plot. 
 
Current Y Rotation:  Current rotation of the plot on the y-axis in degrees.  Entering a value into this text 
field, and pressing Enter, will set the y-axis rotation of the plot. 
 
Current Z Rotation:  Current rotation of the plot on the z-axis in degrees.  Entering a value into this text 
field, and pressing Enter, will set the z-axis rotation of the plot. 
 
X:  Include the x-axis in the auto-rotation step. 
 
Y:  Include the y-axis in the auto-rotation step. 
 
Z:  Include the z-axis in the auto-rotation step. 
 
Step Size:  Set the step size (in degrees) for an axis. 
 
Delay Time:  The delay time (in milliseconds) between auto-rotate steps. 

M20.6.10 37BSET LEGEND FORMAT (2D ONLY) 

The content of the legend can be modified with the Set Legend Format dialog, shown in XFigure M20.6.9X.  
This dialog is activated for the current 2D plot by selecting Format Legend… item from the Format 
menu, by pressing the Format Legend button on the Profile Information dialog, or by choosing 
Edit Legend Contents in the legend pop-up menu. 
 
 

 
 

Figure M20.6.9.  Legend formatting dialog for 2D plots. 

 
 
Show Legend:  Show/Hide the legend. 
 
Dataset Title:  Legend text will include the title for the dataset where the data originated as it was last set 
in theX Dataset OptionsX dialog. 
 
Integral Values:  Legend text will include the sum of the y-values for all x-values, if available. 
 
Region Volume Data:  Legend text will include the volume of the region or zone where the data was 
computed, if available. 
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Unit Comment:  Legend text will include comments from the data file for the particular data type, if 
available. 

M20.6.11 38BLEGEND PLACEMENT (2D ONLY) 

The location of the legend can be changed by clicking on it and dragging it to a new location, then 
releasing the mouse. 

M20.6.12 39BFONTS FOR SELECTED PLOT (2D) 

The Fonts for Selected Plot dialog, shown in XFigure M20.6.10X, accesses available system fonts to allow 
the customization of the selected 2D plot.  This dialog box is accessed by selecting Fonts… from the 
Format menu or by pressing the Fonts button in the Profile Information dialog.  The plot is updated as 
changes are made in this dialog. 
 
 

 
 

Figure M20.6.10.  Font formatting dialog for 2D plots. 

 
 
Title Font:  Font for plot title. 
 
Label Font:  Font for x- and y-axis labels. 
 
Legend Font:  Font to use in the legend. 
 
Tick Font:  Font to use for x and y-axis tick-mark labels. 
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M20.6.13 40B FONTS FOR SELECTED PLOT (3D) 

The Fonts for Selected Plot dialog, shown in XFigure M20.6.11X, accesses available system fonts to allow 
the customization of the selected 3D plot.  This dialog box is accessed by selecting Fonts... from the 
Format menu.   
 
 

 
Figure M20.6.11.  Font formatting dialog for 3D plots. 

 
 
Label Font:  Font for x-, y -, and z-axis labels. 
  
Tick Font:  Font to use for x-, y-, and z-axis tick-mark labels. 

M20.6.14 41B DATASET OPTIONS 

The Dataset Options dialog, shown in XFigure M20.6.12X, allows for changes to a particular dataset loaded 
using the Open Dataset… item of the File menu.  Changes to the dataset title are updated in all open 
plots that contain data from this file and have Dataset Title selected in the Set Legend Format dialog.  
The Dataset Options dialog is accessed by double-clicking on the tab representing the dataset.  Pressing 
any of the buttons causes the selected action to occur.  On some systems, these buttons are reversed in 
order from those shown below.  This dialog box is modal when in applet mode.  It is modeless in 
application mode and will update when changing plots. 
 
 

 
Figure M20.6.12.  Dataset options dialog. 

 
 
Dataset Title:  A customized title can be entered. 
 
Use File Name:  Use the name of the data file as the title. 
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Use File Title:  Use the title on the data file as the title. 
 
Refresh Datafile:  Reloads the data file and refreshes the reaction list. 
 
Remove Datafile:  Remove the dataset from the tab and close its associated data file.  Any plots 
containing data from this data file are left unchanged. 

M20.6.15 42B PROFILE INFORMATION (2D ONLY) 

Options for a particular data curve or “profiλe” are set with the Profile Information dialog, shown in 
Figures XM20.6.13X–M20.6.14 X.  This dialog can only be accessed by double-clicking or right-clicking in the 
portion of the legend where the particular profile is identified.  Changes are reflected in the 2D plot as 
they are made. 
 
If a logarithmic y-axis is used, the absolute values of the data are plotted and the values are identified as 
either positive or negative.  Where both positive and negative values are present in the same profile, the 
colors and styles of the positive and negative values can be separately set, as shown in XFigure M20.6.13X. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure M20.6.13.  Profile information dialog for 2D plots with 

positive and negative values on a logarithmic y-axis. 

 
 
If a linear y-axis is used, the values themselves are displayed, whether positive or negative.  Only a single 
format is used for a profile, as shown in XFigure M20.6.14X. 



 

 
 M20.6.12 

 

 
 

Figure M20.6.14.  Profile information dialog for 2D plots. 

 
 
Color for…:  Set color for the particular data identified.  Colors are shown in the plot if Use Colors is 
selected in the Set Plot Format dialog. 
 
Dash style for …:  Set the dash style for the particular data identified.  Dashes are shown in the plot if Use 

Dashes is selected in the Set Plot Format dialog.   
 
Legend Text:  This is a portion of the legend text specific to this profile.  This does not include text that is 
set with the Set Legend Format dialog. 
 
Dataset Multiplier:  The data for the profile is uniformly multiplied by the value entered, or divided by 
the value entered if use inverse is selected. 
 
Fonts:  Activates the Fonts for Selected Plot dialog. 
 
Format Legend:  Activates the Set Legend Format dialog. 
 
Remove Profile:  Removes the profile from the plot. 

M20.6.16 43B ZOOMING (2D) 

To zoom in on an area of a plot, click on the upper left corner of the desired area and drag to the bottom 
right corner, then release the mouse button.  The view is reset to the selected area.  To zoom out, click on 
the plot, then drag up and to the left, then release the mouse button.  To return to the default view for the 
plot, right-click on the plot and select Fill Plot from the pop-up menu. 
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M20.6.17 44B ZOOMING (3D) 

Zooming in 3D plots is handled through the middle mouse button (on three-button mice).  On two- and 
one-button mice, zooming is performed with the Alt key and the left mouse button.  Zooming is 
performed by pressing and holding the appropriate button(s) and moving the mouse.  Moving the mouse 
down will zoom in.  Moving the mouse up will zoom out. 

M20.6.18 45B PANNING (3D ONLY) 

Panning in 3D plots is handled through the right mouse button (on two- and three-button mice).  On one-
button mice, panning is performed with the Ctrl key and the left mouse button.  Panning is performed by 
pressing and holding the appropriate button(s) and moving the mouse.  The plot will pan in the direction 
the mouse is moved. 

M20.6.19 46B ROTATING (3D ONLY) 

Rotating in 3D plots is handled through the left mouse button.  Rotating is performed by pressing and 
holding the left mouse button and moving the mouse.  The plot will be rotated in the direction the mouse 
is moved. 

M20.6.20 47B PLOT OPERATIONS (2D ONLY) 

Simple mathematical operations can be performed on 2D plots.  To perform an operation, first right-click 
on the 2D plot and choose Perform Operations from the pop-up menu or right-click on an item in the 
reaction list and select Perform Operations.  This will display the Javapeno Calculator dialog, as 
shown in XFigure M20.6.15. 
 
 

 
 

Figure M20.6.15.  Javapeno calculator. 

 
 
This dialog will display profiles available in the currently selected plot as well as all data available from 
plotting in all open data files.  Initial setup of the Javapeno calculator is shown in Figure M20.6.16. The 
Dataset Title and Operation Title can be edited for the current operation.  This information will be 
displayed in the plot legend.  Next, select the profile that will be included in the mathematical operation 
and click Select Data to add them to the Calculator Sources field. 
DataSet Title:  Assigns a parent data set name for use in the legend. 
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Operation Title:  This sets the profile and legend title for the operation.   
 
Data Source:  Open plots or data files that contain information that could be included in a mathematical 
operation. 
 
Calculator Sources:  Information selected by the user to be included in mathematical operations. 
 
 

 
Figure M20.6.16.  Javapeno calculator with information populated. 

 
 
The Set Equation tab, shown in XFigure M20.6.17, diplays profiles that can be used in the operation and 
provides a text field for input and equation for the operation.  Profiles are preceded by the variable that 
represents them in the equation.   
 
 

 
Figure M20.6.17.  Javapeño calculator dialog for 2D plots. 

 
 

Equation:  The equation for the operation is entered in this textbox.  The five basic mathematical 
operators are supported:  +, -, *, /, ^.  The calculator also supports parenthesis ( ).  The following rules 
apply to the equations: 
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1.   Only explicit operations are permitted.  For an example, instead of 3A, the equation has to be 
3*A.  Another example is instead of A(3+B), the equation must be A*(3+B).  A final example is 
instead of (3-B)(-A), the equation must be (3-B)*(0-A) or (3-B)*A.  

2.   Exponential notation, such as 1.2E5, is not supported.  Instead use use non-exponential base 
scientific notation, such as 1.2*10^5.    

  
Plot:  Plot the operation profile in the current plot.  All other profiles will be left alone. 
  
Plot and Remove:  Plot the operation profile in the current plot.  All other profiles will be removed. 
  
Cancel: No operation will be performed.  
 
Plot in:  Location to place operation plot, either in an existing plot or a new plot. 
 
The Set X-Axis tab can be used to select another profile as the x-axis data for the calculated profile.  This 
is especially useful for ORIGEN data plotted from OPUS .plt files where it is desirable to plot one 
concentration as the function of another. 
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M20.7 7BPOP-UP MENUS 

 
The various pop-up menus are described in this section. 

M20.7.1 48BSINGLE-SELECTION POP-UP 

The single section pop-up menu, shown in XFigure M20.7.1 for 2D plots, and in XFigure M20.7.2 for 
3D plots, is displayed when the user right-clicks on the reaction list with only one reaction selected. 
 
 

 
 

Figure M20.7.1.  Single-selection pop-up for 2D plots. 

 
 

 
 

Figure M20.7.2.  Single-selection pop-up for 3D plots. 

 
 

Plot (2D plots):  This option is only displayed if the selected reaction is 2D and the currently selected 
window contains a 2D plot.  The selected reaction will be plotted in the currently selected window. 
 
Plot (3D plots):  This option is only displayed if the selected reaction is 3D and the currently selected 
window contains a 3D plot.  The selected data will replace the current data in the plot. 
 
Plot in New Window:  This option will plot the selected reaction in a new window. 
 
Get Profile Information (KMART and SEN only):  Displays a pop-up window containing additional 
information on the selected reaction. 
 
Plot Std. Dev. By Group (COVERX only):  This option is only displayed if the selected reaction is a 
COVERX reaction.  It will plot the standard deviation of the selected COVERX reaction by energy group 
number in the current window (if it only contains a 2D plot), or create a new window containing the 
standard deviation. 
 
Plot Std. Dev. By Energy (COVERX only):  This option is only displayed if the selected reaction is a 
COVERX reaction.  It will plot the standard deviation of the selected COVERX reaction by energy in the 
current window (if it only contains a 2D plot), or create a new window containing the standard deviation. 
 
Plot Std. Dev. By Group in New Window (COVERX only):  This option is only displayed if the selected 
reaction is a COVERX reaction.  It will plot the standard deviation of the selected COVERX reaction by 
energy group number in a new window. 
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Plot Std. Dev. By Energy in New Window (COVERX only):  This option is only displayed if the selected 
reaction is a COVERX reaction.  It will plot the standard deviation of the selected COVERX reaction by 
energy in a new window. 
 
Perform Operations:  Open the Javapeno Calculator to perform mathematical operations. 
 

M20.7.2 49BMULTIPLE-SELECTION POP-UP 

The multiple selection pop-up menu, shown in XFigure M20.7.3, is displayed when the user right-clicks on 
the Reaction List with more than one reaction selected. 
 
 

 
 

Figure M20.7.3.  Multiple-selection pop-up. 

 
 
Plot All in Current Window (2D only):  This option will only be displayed if all of the selected reactions 
are 2D and the current window only contains a 2D plot.  It will plot all of the selected reactions in the 
current window. 
 
Plot All in New Windows (2D only):  This option will plot all of the selected reactions in a new window. 
 
Plot All in Separate Windows:  This option will plot each selected reaction in its own window. 
 
Plot All in Current Window (3D in separate window):  This option will only be displayed if a mixture of 
2D and 3D reactions are selected and the currently selected window only contains a 2D plot.  It will plot 
all of the selected 2D plots in the current window and create a new window for each selected 3D reaction. 
 
Plot All in New Window (3D in separate windows):  This option will only be displayed if a mixture of 2D 
and 3D reactions are selected.  It will plot all of the 2D reactions in a new window and plot each of the 
selected 3D reactions in its own window. 
 
Plot All Std. Dev. By Group in Current Window (COVERX only):  This option will only be displayed if 
the currently selected window only contains a 2D plot.  This option will plot the standard deviation of the 
selected COVERX reactions by energy group number in the current window. 
 
Plot All Std. Dev. By Energy in Current Window (COVERX only):  This option will only be displayed if 
the currently selected window only contains a 2D plot.  This option will plot the standard deviation of the 
selected COVERX reactions by energy in the current window. 
 
Plot All Std. Dev. By Group in New Window (COVERX only):  This option will plot the standard 
deviation of the selected COVERX reactions by energy group number in a new window. 
 
Plot All Std. Dev. By Group in New Window (COVERX only):  This option will plot the standard 
deviation of the selected COVERX reactions by energy in a new window. 
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Plot All Std. Dev. By Group in Separate Windows (COVERX only):  This option will create a new 
window for each selected COVERX reaction.  The new window will contain the standard deviation of the 
selected reaction by energy group number. 
 
Plot All Std. Dev. By Energy in Separate Windows (COVERX only):  This option will create a new 
window for each selected COVERX reaction.  The new window will contain the standard deviation of the 
selected reaction by energy. 
 
Perform Operations:  Open the Javapeno Calculator to perform mathematical operations 
 

M20.7.3 50BLEGEND POP-UP (2D ONLY) 

The legend pop-up menu, shown in XFigure M20.7.4, is displayed when the user right-χλicks on a 2D plot’s 
legend. 
 
 

 
 

Figure M20.7.4.  Legend pop-up for 2D plots. 

 
 

Edit Selected Profile:  This option will open the Profile Information (2D only) dialog. 
  
Create Table for Selected Profile:  This option will create a table containing only the selected profile. 
  
Remove Selected Profile:  This option will remove the selected profile from the plot. 
  
Remove All:  This option will remove all profiles from the plot. 
  
Edit Legend Contents:  This option will display the Set Legend Format (2D only) dialog. 
  
Hide Legend:  This option will hide the legend. 
  
Perform Operations:  Open the Javapeno Calculator to perform mathematical operations. 
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M20.7.4 51BPLOT POP-UP (2D) 

The plot pop-up menu for 2D plots, shown in Figure M20.7.5X, is displayed when the user right-clicks on a 
2D plot, except on the legend area. 
 
 

 
 

Figure M20.7.5.  Plot pop-up for 2D plots. 

 
 
Format Options:  This option displays the Set Plot Format dialog Options tab. 
  
Set Titles:  This option displays the Set Plot Format dialog Titles tab. 
  
Set Ranges:  This option displays the Set Plot Format dialog Ranges tab. 
  
Format Axes:  This option displays the Set Plot Format dialog Axes tab. 
  
Fill Plot:  This option resets the axis ranges to the actual values and then redraws the plot. 
  
Reload Plot:  This option clears the plot, reloads each profile from its datafile, and then replots the 
profiles. 
  
Create Table:  This option creates a table containing all of the profiles on the plot. 
  
Perform Operations:  Open the Javapeno Calculator to perform mathematical operations. 
  
Update Configuration File:  This option opens the Configuration File Editor and uses the selected 2D 
plot as the source for the 2D settings in the editor. 
  
Apply Configuration File to the Plot:  This option applies the current configuration file settings to the 
plot. 
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M20.7.5 52BPLOT POP-UP (3D) 

The plot pop-up menu, shown in XFigure M20.7.6X, is displayed when the user shift+right-clicks on a 
3D plot. 
 
 

 
 

Figure M20.7.6.  Plot pop-up for 3D plots. 

 
 
Format Options:  This option displays the XSet Plot FormatX dialog XPlot Options (3D) X tab. 
  
Set Titles:  This option displays the XSet Plot FormatX dialog XPlot Titles (3D)X tab. 
  
Set Ranges:  This option displays the XSet Plot FormatX dialog XPlot Ranges (3D)X tab. 
  
Set Rotations:  This option displays the XSet Plot FormatX dialog XPlot Rotation (3D Only) X tab. 
  
Fill Plot:  This option resets the axis ranges to the actual values and then redraws the plot. 
  
Create Table:  This option creates a table containing all of the profiles on the plot. 
  
Update Configuration File:  This option opens the XConfiguration File Editor X and uses the selected 3-D 
plot as the source for the 3-D settings in the editor. 
  
Apply Configuration File to the Plot:  This option applies the current configuration file settings to the 
plot. 
  
 
 





 

 
 M20.8.1 

 

M20.8 8BREACTION LISTS 

 
Javapeño contains a Reaction List window that displays the profiles that are available for plotting.  
Depending on the type of datafile opened, the Reaction List may be displayed as either a filterable list or 
a tree.  AMPX datafiles are displayed as a tree.  All other datafiles are displayed as a filterable list. 

M20.8.1 53BTREE 

Cross-section datafiles are displayed as a tree, as shown in XFigure M20.8.1X. 
 
 

 
Figure M20.8.1.  Tree for AMPX data. 

 
 

The profiles stored in tree are grouped as follows: 
 

1. Mixture (if available) 
2. Nuclide 
3. Neutron/Gamma/Gamma Production 
4. Transfer Array/Reaction Cross Section 
5. Temperature (if available) 
6. MT symbol (if available) 

 
Sort Tree:  Sorts the tree as follows: 
 

1. Sorts the top level of the tree (either nuclide or mixture) in ascending order, according to its 
ASCII value.   

2. If the top level is a mixture, then the second level is sorted in ascending order according to its 
ASCII value.  
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M20.8.2 54BFILTERABLE LIST 

All data files except cross-section data files are displayed as a filterable list, as shown in XFigure M20.8.2. 
 
 

 
 

Figure M20.8.2.  Filterable list. 

 
 
To filter the list, type the desired word or phrase into the text field.  Only profiles with labels containing 
the search term are displayed.  NOTE:  The filtering is case-sensitive.  To clear the filter, click the 
X button. 
 
X:  Clears the filter. 
 
Sort List:  Sorts the list in ascending order according to the ASCII values of the profile labels.   
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M20.9 9BCONFIGURATION FILE EDITOR 

 
Javapeño has the ability to store many settings in a configuration file so that user options can be saved 
and reused through multiple Javapeño sessions.  The configuration file is called .javapenopc and is stored 
in the users’ home directorψ.  The Configuration File Editor dialog provides an interface to the 
configuration file.   The dialog is always modal.  The values in the configuration file are used as the 
default values for various settings when creating new objects (such as plots).  Since they are default 
values, they do not take precedence over datafile settings (such as values explicitly specified in general 
2D plot data fiλes).  Datafiλe settings for eaχh of Javapeño’s supported data tψpes are desχribed iν 

Sect. XM20.1X for the data type.  It should be noted that the configuration file does take precedence over the 
stated defaults listed in Sect. XM20.6.8X. 
  
The dialog has five tabs each containing various configuration settings and two buttons, as shown in  
XFigure M20.9.1X. 
 
 

 
Figure M20.9.1.  Configuration file editor. 
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Javapeno Options:  This tab holds all of the plot independent options. 
  
2D Options:  This tab holds all of the 2D options (except fonts). 
  
2D Font Options:  This tab holds all of the 2D font options. 
  
3D Options:  This tab holds all of the 3D options (except fonts). 
  
3D Font Options:  This tab holds all of the 3D font options. 
  
OK Button:  This button will update the configuration file with all of the settings that are selected to be 
updated.  New objects (such as plots) will also use the updated settings. 
  
Cancel Button:  This button will close the dialog.  No changes or updates will occur. 
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M20.9.1 55BJAVAPEÑO OPTIONS 

The Javapeño Options tab, shown in XFigure M20.9.2, holds all of the plot independent options.  To 
update a setting, check the Update:  checkbox for the setting and set the setting’s value. 
 
 

 
Figure M20.9.2.  Javapeño options in configuration file editor. 
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Use File Name:  Use the data fiλe’s fiλe name in the Reaction List (or tree) tab. 
  
Use File Title:  Use the data fiλe’s fiλe titλe in the Reaction List (or tree) tab. 
  
Use Lethargy:  Make histogram plots with energy on the x-axis on a per unit lethargy basis. 
 
Open Directory:  This is the default location for the Open Dataset or Open Plot dialog boxes. 
  
Export Directory:  This is the default location for the Export dialog (both plot and table). 
  
Open FileFilter Index:  This is the index value for the file type filter in the Open Dataset dialog box.  
This must be a value >=0 and corresponds to the index of the item selected in the File Format pop-up in 
the Open dialog box, where the index of the first item is 0. 
  
Export Plot FileFilter Index:  This is the index value for the file type filter in the Export dialog box 
(plot).  This must be a value >=0 and corresponds to the index of the item selected in the File Format 
pop-up in the Save dialog box, where the index of the first item is 0. 
  
Export Table FileFilter Index:  This is the index value for the file type filter in the Export dialog box 
(table).   This must be a value >=0 and corresponds to the index of the item selected in the File Format 
pop-up in the Save dialog box, where the index of the first item is 0. 
  
Copy Column Headers:  Copy the table column headings when copying table data. 
  
Open Browser Command:  Command to pass to the operating system to launch a web browser. 
 
No To All For Multiple Selections:  If checked, no prompt will appear if an already plotted profile is 
added to a 2D plot through a multiple selection action (such as Plot All).  Instead, the already plotted 
profile will be skipped during the action. 
  
MenuFont Title:  Sets the font to use for all of the menus.  The drop-down list contains a list of fonts 
installed on the system.  Changing the font name will update the MenuFont Title, MenuFont Size, and 
MenuFont Style labels with the selected font. 
  
MenuFont Size:  The point size to use for the menu font.  The value must be an integer and > 0.  Pressing 
Enter after changing the size will update the MenuFont Size label with the new size. 
  
MenuFont Style:  Sets the style of the menu font.  The drop-down list contains the valid styles.  Changing 
the font style will update the MenuFont Style label with the selected style. 
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M20.9.2 56B2D OPTIONS 

The 2D Options tab, shown in XFigure M20.9.3X, holds all of the 2D options (except fonts).  To update a 
setting, check the Update: checkbox for the setting and set the setting’s value. 
 
 

 
Figure M20.9.3.  2D options in configuration file editor. 
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Marks:  Choose the tψpe of µ arker to use on the 2D plot’s data points. 
  
Lines:  If checked then the 2D plot’s data points wiλλ be connected with lines. 
  
Impulses:  If selected, a line will be drawn from each data point to the x-axis (for log plots) or to y=0 
(for linear plots). 
  
Bars:  If selected, 2D plots are treated as bar graphs by default. 
  
Auto-move Legend:  If selected, the automoving legend feature will be turned on by default for 2D plots. 
  
Grid:  If selected, x and y axis grid lines will be displayed. 
  
X-Grid:  If selected, x-axis grid lines will be displayed. 
  
Y-Grid:  if selected, y-axis grid lines will be displayed. 
  
More Grid:  If selected, more grid lines will be shown (if x or y gridlines are displayed). 
  
X-Log:  If selected, the x-axis will be in log scale. 
  
Y-Log:  If selected, the y-axis will be in log scale. 
  
Color:  If selected, the 2D plot will be in color. 
  
LineWidth:  The 2D plot linewidth.   The value must be > 0. 
  
Dash:  If selected, lines drawn between data points will be drawn as dashes. 
  
Error Bars:  If selected, error bars will be drawn on data points that contain uncertainty data. 
  
2D Text Color:  Specifies the color to use for the text on the 2D plot.  The color swatch next to the button 
will be updated if the value is changed. 
  
2D Back Color:  Specifies the color to use for the background on the 2D plot.  The color swatch next to 
the button will be updated if the value is changed. 
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M20.9.3 57B2D FONT OPTIONS 

The 2D Font Options tab, shown in XFigure M20.9.4 X, holds all of the 2D font options.  To update a 
setting, check the Update:  checkbox for the setting and set the setting’s value. 
 
 

 
Figure M20.9.4.  2D font options in configuration file editor. 
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TitleFont Title:  Sets the font to use for the 2D plot title.  The drop-down list contains a list of fonts 
installed on the system.  Changing the font name will update the TitleFont Title, TitleFont Size, and 
TitleFont Style labels with the selected font. 
  
TitleFont Size:  The point size to use for the title font.  The value must be an integer and > 0.  Pressing 
Enter after changing the size will update the TitleFont Size label with the new size. 
  
TitleFont Style:  Sets the style of the title font.  The drop-down list contains the valid styles.  Changing 
the font style will update the TitleFont Style label with the selected style. 
  
LegendFont Title:  Sets the font to use for the 2D plot legend.  The drop-down list contains a list of fonts 
installed on the system.  Changing the font name will update the LegendFont Title, LegendFont Size, 
and LegendFont Style labels with the selected font. 
  
LegendFont Size:  The point size to use for the legend font.  The value must be an integer and > 0.  
Pressing Enter after changing the size will update the LegendFont Size label with the new size. 
  
LegendFont Style:  Sets the style of the legend font.  The drop-down list contains the valid styles.  
Changing the font style will update the LegendFont Style label with the selected style. 
  
2D TickFont Title:  Sets the font to use for the 2D plot tick-value labels.  The drop-down list contains a 
list of fonts installed on the system.  Changing the font name will update the 2D TickFont Titles, 
2D TickFont Size, and 2D TickFont Style labels with the selected font. 
  
2D TickFont Size:  The point size to use for the 2D tick font.  The value must be an integer and > 0.  
Pressing Enter after changing the size will update the 2D TickFont Size label with the new size. 
  
2D TickFont Style:  Sets the style of the 2D tick font.  The drop-down list contains the valid styles.  
Changing the font style will update the 2D TickFont Style label with the selected style. 
  
2D LabelFont Title:  Sets the font to use for the 2D plot axis labels.  The drop-down list contains a list of 
fonts installed on the system.  Changing the font name will update the 2D LabelFont Title, 
2D LabelFont Size, and 2D LabelFont Style labels with the selected font. 
  
2D LabelFont Size:  The point size to use for the 2D axis label font.  The value must be an integer and 
> 0.  Pressing Enter after changing the size will update the 2D LabelFont Size label with the new size. 
  
2D LabelFont Style:  Sets the style of the 2D axis label font.  The drop-down list contains the valid styles.  
Changing the font style will update the 2D LabelFont Style label with the selected style. 
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M20.9.4 58B3D OPTIONS 

The 3D Options tab, shown in XFigure M20.9.5, holds all of the 3D options (except fonts).  To update a 
setting, check the Update:  checkbox for the setting and set the setting’s value. 
 
 

 
Figure M20.9.5.  3D options in configuration file editor. 
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3D Text Color:  Specifies the color to use for the text on the 3D plot.  The color swatch next to the button 
will be updated if the value is changed. 
  
3D Background Color:  Specifies the color to use for the background on the 3D plot.  The color swatch 
next to the button will be updated if the value is changed. 
  
Plot Type:  Sets whether 3D plots are displayed in Lego or Surface mode. 
  
Plot View:  Sets whether 3D plots are view Parallel or Perspective mode. 
  
Plot Transparency:  The position of the slider sets how transparent (or opaque) to make the 3D plot. 
  
Plot Sparification Threshold:  This sets the maximum number of wires to display when the 3D plot is in 
wire-frame mode.   This must be an integer value > 0. 
  
Plot Scale:  This sets the 3D plot scale.  The scale value is a straight multiplier for plot data and is an 
inverse multiplier for the plot text.   This must be a value >0. 
  
X Rotation:  The position of the slider sets the startup x-axis rotation for the 3D plot. 
  
Y Rotation:  The position of the slider sets the startup y-axis rotation for the 3D plot. 
  
Z Rotation:  The position of the slider sets the startup z-axis rotation for the 3D plot. 
  
COVERX Standard Deviation:  Sets whether COVERX plots will have their associated standard deviation 
plots shown by default. 
  
COVERX Correlation Coefficient:  Sets whether COVERX plots will have correlation coefficient data 
displayed by default. 
  
AMPX Normalized Probability:  Sets whether AMPX P0 plots will have normalized probability data 
displayed by default. 
  
AMPX Avg. Cos. of Scat. Angles:  Sets whether AMPX P1 plots will have the average cosine of the 
scattering angles data displayed by default. 
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M20.9.5 59B3D FONT OPTIONS 

The 3D Font Options tab, shown in XFigure M20.9.6 X, holds all of the 3D font options.  To update a 
setting, check the Update: checkbox for the setting and set the setting’s value. 
 
 

 
Figure M20.9.6.  3D font options in configuration file editor. 

  



 

 
 M20.9.12 

3D LabelFont Title:  Sets the font to use for the 3D plot labels.  The drop-down list contains a list of fonts 
installed on the system.  Changing the font name will update the 3D LabelFont Title, 3D LabelFont 

Size, and 3D LabelFont Style labels with the selected font. 
  
3D LabelFont Size:  The point size to use for the 3D label font.  The value must be an integer and > 0.  
Pressing Enter after changing the size will update the 3D LabelFont Size label with the new size. 
  
3D LabelFont Style:  Sets the style of the 3D label font.  The drop-down list contains the valid styles.  
Changing the font style will update the 3D LabelFont Style label with the selected style. 
  
3D TickFont Title:  Sets the font to use for the 3D plot ticks.  The drop-down list contains a list of fonts 
installed on the system.  Changing the font name will update the 3D TickFont Title, 3D TickFont Size, 
and 3D TickFont Style labels with the selected font. 
  
3D TickFont Size:  The point size to use for the 3D tick font.  The value must be an integer and > 0.  
Pressing Enter after changing the size will update the 3D TickFont Size label with the new size. 
  
3D TickFont Style:  Sets the style of the 3D tick font.  The drop-down list contains the valid styles.  
Changing the font style will update the 3D TickFont Style label with the selected style. 
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M20.10 10BKNOWN ISSUES 

 
While thoroughly tested, Javapeño is known to have the following issues: 
 

1. Unpredictable colors/symbols when zooming/resizing a 3D plot (Mac) 
a. Sometimes when zooming or resizing a 3D plot on a Mac computer, some discoloration 

or odd symbols may appear on the plot. 
b. In most cases performing an action that causes the whole plot to be redrawn will fix this 

problem.  An example of such action is setting the plot scale in the Set Plot Format 
dialog. 

 
2. In applet mode the 3D plot moves up and down when scrolling (All) 

a. This is a result of the interaction of the Java 3D object (3D plot) and the rest of Javapeño 
(applet). 

b. The plot should be back in its original position when the scroll bar is returned to its 
original position.  Another option is to pan the plot to the desired position after scrolling. 

 
3. Some dialog boxes open behind plots (Mac) 

a. Dialog boxes, such as Set Plot Format, open behind plots instead of on top of the plot 
windows. 

b. This seems to be a Mac only issue.  No work around has been found.  It is believed to be 
a result of the Mac implementation of Java. 

 
4. Java heap space errors (All, Applet or Application mode) 

a. Please see M20.10.1. 
 

5. Cannot increase the amount of memory allocated to Java. 
a. You are unable to increase the value of NUM described in Sect. XM20.10.1X.  This is 

usually caused in two ways: 
i. The value of NUM is greater than the amount of RAM on the system. 

ii. The value of NUM is greater than the amount of free RAM on the system.  The 
JVM requires the value of NUM to be available in sequential blocks of memory. 

b. If the cause is case i, then the only solution is installing more RAM. 
c. If the cause is case ii, then try the following: 

i. Close other applications, set NUM to the desired value, and then try launching 
Javapeño. 

ii. Restart your computer, set NUM to the desired value, and then try launching 
Javapeño. 
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M20.10.1 60BCONFIGURING JAVA FOR 3D PLOTTING 

Note that 3D plots require a lot of memory.  Java, by default, does not allocate enough memory for its 
virtual machine to have more than a few (if any) 3D plots open.  To fix this, please follow these steps: 
 

1. For Javapeño in application mode:  Just run the bat file/shell script provided with Javapeño.  If 
you are still having problems, then you may need to alter the bat file/shell script. 

a. Open the bat file/shell script in your favorite text editor. 
b. Add (or µ odifψ) “-Xµ xNUMm” to the Java Runtiµ e Parameters field (without quotes).  

NUM should be the amount of memory to give to Java.  The m after NUM means 
megabytes (or million bytes) 

c. Increase the value of NUM. 
d. WARNING:  Entering too large of a value for num will prevent Java from starting. 
 

2. For Javapeño in applet mode: 
a. Windows: 

i. Open Control Panel and double left-click on the Java icon. 
ii. Click on the Java tab. 

iii. Click on the View button in the Java Applet Runtime Settings. 
iv. Add (or µ odifψ) “-Xµ xNUMm” to the Java Runtiµ e Parameters fieλd (without 

quotes).  NUM should be the amount of memory to give to Java.  The m after 
NUM means megabytes (or million bytes) 

v. WARNING:  Entering too large of a value for NUM will prevent Java from 
starting. 

b. Mac: 
i. Open Finder. 

ii. Click on Applications. 
iii. Double-click on Utilities. 
iv. Double-click on Java. 
v. Double-click on J2SE 5.0. 

vi. Double-click on Java Settings. 
vii. Add (or µ odifψ) “-Xµ xNUMm” to the Java Applet Runtiµ e Parameters fieλd 

(without quotes).  NUM should be the amount of memory to give to Java.  The m 
after NUM means megabytes (or million bytes) 

viii. WARNING:  Entering too large of a value for NUM will prevent Java from 
starting. 

c. Linux: 
i. Launch ControlPanel from the Java JRE bin.  The JRE bin should be located at 

<Java_Installation_Dir>/jre/bin. 
ii. Click on the Java tab. 

iii. Click on the View button in the Java Applet Runtime Settings. 
iv. Add (or µ odifψ) “-Xµ xNUMm” to the Java Runtiµ e Parameters fieλd (without 

quotes).  NUM should be the amount of memory to give to Java.  The m after 
NUM means megabytes (or million bytes) 

v. WARNING:  Entering too large of a value for NUM will prevent Java from 
starting. 
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M20.10.2 61BSPECIAL APPLET INSTRUCTIONS 

Javapeño includes a full featured applet mode.  All features included in the application mode can now be 
used in the applet mode.  To accomplish this, the Javapeño applet had to be signed with a security 
certificate.  Before running Javapeño in applet mode, the certificate must be accepted.  Please follow 
these steps to accept the certificate: 
 
When opening a SCALE-generated HTML output page containing the Javapeño applet, you may see a 
dialog similar to that shown in XFigure M20.10.1X. 
 
 

 
Figure M20.10.1.  Digital signature dialog for Javapeño applet. 

 
 
When clicking on More Information… in the lower right corner of the dialog, the dialog shown in  
XFigure M20.10.2 will appear. 
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Figure M20.10.2.  More information dialog for digital signature for Javapeño applet. 

 
 

Clicking on Certificate Details…, verify that the following information is correct. 
 The version value should be:  V1 
 Serial Number should be:  1152193411 
 Signature Algorithm should be:  SHA1withDSA 
 Issuer should be:   

o CN=Javapeño, 
o OU=NSTD, 
o O=Oak Ridge National Laboratory, 
o L=Oak Ridge, 
o ST=TN, 
o C=US 

 Validity should be: 
o From Thu Jul 06 09:43:32 EDT 2006, 
o To:  Sun Jul 03 09:43:31 EDT 2016 

 Subject should be: 
o CN=Javapeño, 
o OU=NSTD, 
o O=Oak Ridge National Laboratory, 
o L=Oak Ridge, 
o ST=TN 
o C=US 

 The signature contains three lines.  Each line contains (up to) 16 hexadecimal pairs followed by a 
“readabλe” version of the λine.  Please verifψ that the hexadeciµ al pairs match: 

o Line 0000: 30 2C 02 14 43 B0 6A 05  9D 92 72 24 6F D7 A5 77 
o Line 0010: B0 BB 8A 32 B8 14 E4 3D  02 14 7E 2B F4 83 BC 55 
o Line 0020: E9 95 F2 E9 98 03 95 BE  DB 2C B4 2E 48 7E 

 
If all of the above matches, the applet has been authenticated.  Click Close on the Details dialog.  Click 
Close on the More Information dialog.  Check the box to always trust content from this publisher.  Then 
click Run.  The applet should now load.  If you are using Internet Explorer, you may need to allow active 
content on the webpage and then click on the applet. 
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